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Read through this operating manual carefully before use and become familiar with the product. 
Installation and start-up should not be carried out before reading and understanding this 
document. Keep this manual readily available so that you can reference it as needed. 
 

1.1  What Is the Purpose of this Operating Manual? 
This manual serves as an aid for the installation and operation of the product and supports the 
technical staff with all operating and maintenance tasks to be performed. Furthermore, this 
manual is aimed at preventing dangers to life and health of the user and third parties. 
 

1.2  Who Is this Operating Manual Targeted to? 
The operating manual provides a code of conduct for personnel tasked with the setup, 
operation, maintenance, and repair of gas engines. A certain level of technical knowledge with 
respect to the operation of gas engines and basic knowledge of electronic ignition systems are 
necessary. Persons who are only authorized to operate the gas engine shall be trained by the 
operating company and shall be expressly instructed concerning potential hazards. 
 

1.3  Which Symbols Are Used in the Operating Manual? 
The following symbols are used in this manual and must be observed: 

 

Example 

This symbol indicates examples, which point out necessary handling steps 
and techniques. In addition, you receive additional information from the 
examples, which will increase your knowledge. 

   

 

Notice 

This symbol indicates important notices for the user. Follow these. In 
addition, this symbol is used for overviews that give you a summary of the 
necessary work steps. 

   

 

Warning 

This symbol indicates warnings for possible risks of property damage or 
risks to health. Read these warning notices carefully and take the 
mentioned precautionary measures. 

   

1 General Information 
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Danger 

This symbol indicates warnings for danger to life, especially due to high 
voltage. Read these warning notices carefully and take the mentioned 
precautionary measures. 

  
 

1.4  Which Abbreviations/Acronyms Are Used in the Operating Manual? 
In the manual or the user interface, the following abbreviations/acronyms are used. 

Abb. Term Description Explanation 

ADV Advance Advanced with 
respect to top 
dead center 

Indicates the direction for 
timing 

ASO Auxiliary 
Synchronization 
Output 

  Output for synchronizing the 
MIC100 and other controllers 

ATDC After Top Dead 
Center 

    

BTDC Before Top Dead 
Center 

    

CAN bus Controller Area 
Network bus 

Bus for control 
devices/networks 

Asynchronous serial 
connection system for linking 
control units 

CE Conformité 
Européenne 

Conformity with 
EU directives 

Mark based on EU legislation 
for certain products in 
conjunction with product safety 

CPU Central Processing 
Unit 

    

°crankshaft Degree crankshaft   Unit for the rotation angle of 
the crankshaft 

CSA Canadian Standards 
Association 

  Organization that defines 
standards, inspects products 
for safety compliance, and 
issues pertinent certifications. 

DC Direct Current     

DetCon Detonation Control 
System 

  Serves to prevent major engine 
damage that can be caused by 
knocking combustion. 
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Abb. Term Description Explanation 

EMI Electromagnetic 
Interference 

    

EMC Electromagnetic 
Compatibility 

  Compatibility of electrical or 
electronic equipment items 
with their surroundings 

HV High Voltage     

ISO International 
Organization for 
Standardization 

    

LED Light Emitting Diode   Light emitting electronic 
semiconductor 

MIC MOTORTECH Ignition 
Controller 

    

MICT MOTORTECH 
Integrated 
Configuration Tool 

  Software for the configuration 
of the MIC100 

PG Panzergewinde Panzer Screw 
Thread 

Screw thread type for cable 
screw connections 

RET Retard Retarded with 
respect to the top 
dead center 

Indicates the direction for 
timing 

RS485/ 
TIA485 

Recommended 
Standard 485/ 
Telecommunications 
Industry Association 
485 

  Industrial standard for a 
physical interface for 
asynchronous serial data 
transfer 

TDC Top Dead Center     

USB Universal Serial Bus   Serial connection system to 
link a computer to external 
devices 
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2.1  General Safety Instructions 
The following safety instructions must be followed in the area in which the device is operated: 

  

 

High voltage! Danger to life! 

While the engine is running, the area around the ignition system especially 
holds the risk of danger due to high voltage. The following parts should 
therefore not be touched or removed unless explicitly stated otherwise: 

– Ignition coils and caps 

– Wires of the high voltage circuit 

– In- and output wiring of the ignition controller 

– Pickups and their wiring 

    

  

Danger to persons with pacemakers! 

Electromagnetic impulses in the wiring of the ignition system may exceed 
the permissible limits of pacemakers. Persons with pacemakers must 
therefore not be present in the vicinity of the ignition system being 
operated. Mark the operating location of the ignition system with the 
corresponding standardized warning symbol. 

  

MOTORTECH equipment is manufactured as state of the art and therefore safe and reliable to 
operate. Nevertheless the equipment can cause risks or damage can occur, if the following 
instructions are not complied with: 

– The gas engine must only be operated by trained and authorized personnel. 

– Observe all safety instructions of the system and all safety instructions of the system 
operator. 

– Operate the equipment only within the parameters specified in the technical data. 

– Use the equipment correctly and for its intended use only. 

– Never apply force. 

– For all work such as installation, conversion, adaptation, maintenance, and repair, all 
equipment must be disconnected from the mains and secured against unintentional 
reactivation. 

– Perform only such maintenance and repair work as is described in this operating manual, 
and follow the instructions given while working. 

– Only use spare parts supplied by MOTORTECH for the maintenance of the device. 

– Further work must only be performed by personnel authorized by MOTORTECH. Non-
compliance with the instructions will void any warranties for the proper function of the 
equipment as well as the responsibility for the validity of the certifications. 

2 Safety Instructions 
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– Safety devices must not be dismounted or disabled. 

– Avoid all activities that can impair the function of the equipment. 

– Operate the equipment only while it is in proper condition. 

– Investigate all changes detected while operating the gas engine or ignition system. 

– Ensure compliance with all laws, directives, and regulations applicable to the operation of 
your system, including such not expressly stated herein. 

– If the system is not entirely tight and sealed, gas may escape and result in explosion hazard. 
The inhalation of gas can also lead to death or severe health damages. Therefore, upon 
completion of all assembly works, always check the system's tightness. 

– Always ensure adequate ventilation of the engine compartment. 

– Ensure a safe position at the gas engine. 

– There is a risk of burning on hot surfaces. Allow the engine to cool down before starting any 
work. 

– Personal protective equipment (PPE), e.g. safety shoes and gloves, must be worn during all 
work on the engine. 

– Noise from the system can cause permanent or temporary damage to your hearing. Wear 
suitable hearing protection at the system. 

– Your behavior can reduce possible residual risks to a minimum. Observe responsible 
handling of the gas engine and the gas-carrying system. 

 

2.2  Electrostatic Discharge Hazards 
Electronic equipment is sensitive to static electricity. To protect these components from damage 
caused by static electricity, special precautions must be taken to minimize or prevent 
electrostatic discharge. 

Observe these safety precautions while you work with the equipment or in its vicinity. 

– Before performing maintenance or repair work, ensure that the static electricity inherent to 
your body is discharged. 

– Do not wear clothing made from synthetic materials to prevent static electricity from 
building up. Your clothing should therefore be made of cotton or cotton mix materials. 

– Keep plastics such as vinyl and Styrofoam materials as far away from the equipment as 
possible. 

– Do not remove the circuit boards from the housing of the device. 
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2.3  Information on Electric Isolation 
If ground and earth potential are not properly isolated, the following problems as well as others 
can occur: 

– Electromagnetic interferences (e.g. ground loops) 

– Signal corruption (e.g. of the analog voltage signal) 

– Unwanted leakage currents 

Therefore, earth potential and the negative pole of the power supply of all devices in the electric 
assembly that provide the option, should be connected separately. If possible, the negative pole 
of the power supply should only be connected to earth potential at one point in the entire 
system. 

Wiring Example 
      Device with 

shielded wires 
Device featuring 
protection class II 
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Occurrence of ground loops 

The devices shown in the following image do not feature the possibility to 
connect the earth potential and the negative pole of the power supply 
separated from each other. How ground loops are created. 

A ground loop is a ground connection of an electric wiring assembly that is 
closed as a loop. Due to impedance (resistance R > ) of the loop, low-
frequency interference currents can lead to an unwanted voltage drop in the 
signal path. 

  Device 1   Device 2 

 
    Ground loop   

 

    
 

2.4  Special Safety Instructions for the Device 
  

 

Danger to life! Hazardous residual voltage! 

After stopping the ignition, there is dangerous residual voltage for up to 
three minutes in the ignition system. Do not touch any components of the 
ignition kit during this time. 

    

 

Explosion hazard! 

If the system is located in a hazardous area, never open the device (e.g . by 
opening the service screw). There is a risk of explosion. 
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Explosion hazard! 

Do not disconnect any connectors while the system is live. If the system is 
located in a hazardous area, there is a risk of explosion. 

    

 

Explosion hazard! 

Never remove the equipment while the unit is connected to a power source. 
If the system is located in a hazardous area, there is a risk of explosion. 

    

 

Explosion hazard! 

Do not remove or replace the fuse while the equipment is live. 

     

 

Risk of burning! 

The surfaces of the system may heat up to high temperatures. 

    

 

Operational safety! 

All connector screws and screw joints must be adequately tightened. 

    

 

Operational safety! 

The proper functioning of the device is only guaranteed if the device is 
operated within the permissible supply voltage range. Therefore, use a 
power supply in accordance with the specifications in the operating 
manual. 
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Risk of destruction! 

Magnetic fields and heat occur when welding, which may damage or 
destroy the MIC100. Therefore, pay attention to the following when welding: 

– Disconnect all electrical connections to the MIC100 prior to welding. 

– Protect the MIC100 against direct contact with the welding unit and 
magnetic fields, sparks and liquid metal. 

     

 

Danger of interference with radio reception! 

The device is not intended for use in residential areas and cannot ensure 
adequate protection of radio reception in such environments. 

  
 

2.5  Proper Disposal 
After the expiration of its service life, MOTORTECH equipment can be disposed of with other 
commercial waste, or it may be returned to MOTORTECH. We will ensure its environmentally 
friendly disposal. 
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3.1  Functional Description 
The devices of the MIC100 series are microprocessor controlled ignition systems, each 
consisting of a board with a 32 bit main processor (CPU). 

Please note that the manufacturer is not generally required to implement configurations of the 
ignition controller for specific engines, and that devices may be delivered without pertinent 
configuration. 

The ignition controllers of the MIC100 series use information supplied by the pickup to precisely 
determine the correct timing for the respective outputs. The ignition timing is influenced by 
various inputs. This can be implemented using analog input signal, a speed characteristic, or 
using a serial interface (CAN bus). 

By checking the information received, the ignition controllers continuously monitor the system 
status of the installed pickup and the correct operation of the primary ignition circuit during 
operation. 

Depending on the severity of an error that is detected, the device will shut down immediately or 
warn the operator. A corresponding message can be viewed on a connected computer. 

To protect the engine, the ignition controllers additionally have an adjustable overspeed shut-
off. 
 

3.2  Applications 
The ignition controllers of the MIC100 series are designed for specific 2- or 4-stroke gas engines. 
From 1 to max. 8 ignition outputs are available. 

The ignition controllers supply the energy required for the corresponding ignition coils of the 
gas engines and can supply signals for peripheral equipment. 

Any use other than the one described in the operating manual shall be considered improper use 
and will result in the voiding of all warranties. 

 

3 Intended Use 
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4.1  Technical Data 

4.1.1 Certifications 
The ignition controllers of the MIC100 series are certified as per the following 
directives/regulations: 

CE 
EMC Directive 2014/30/EU 

– EN 61326-1:2013 – Electrical equipment for measurement, control and laboratory use. EMC 
requirements. General requirements 

– EN 61000-6-2:2005 + AC:2005 – Electromagnetic compatibility (EMC). Generic standards. 
Immunity for industrial environments 

– EN 61000-6-4:2007 + A1:2011 – Electromagnetic compatibility (EMC). Generic standards. 
Emission standard for industrial environments 

– EN 55011:2009 + A1:2010 – Industrial, scientific and medical equipment. Radio-frequency 
disturbance characteristics. Limits and methods of measurement 

– Group1, Class A 

Low Voltage Directive 2014/35/EU 

– EN 61010-1:2010 – Safety requirements for electrical equipment for measurement, control, 
and laboratory use. General requirements 

– EN 60529:1991 + A1:2000 + A2:2013 + AC:2016-12 + AC:2019-02  – Degrees of protection 
provided by enclosures (IP Code) 

RoHS Directive 2011/65/EU 
 

4 Product Description 
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4.1.2 Mechanical Data 
The MIC100 has the following mechanical characteristics. 

Feature Value 

Dimensions 232 mm x 190 mm x 55.5 mm (9.1" x 7.5" x 2.2") 
(length x width x height) 

Weight 1.6 kg ( 3.5 lbs)  

Shape of device See chapter Overview Drawings on page 24 

Mechanical environmental 
conditions 

The housing is resistant to general atmospheric 
contaminations. 

Resistant to gas engine lubricants and cooling water. 

Protection class: I 
Protection: IP69k 

The specified protection classes and types are only 
guaranteed if all external wiring connections are made in 
accordance with the connector specification, all covers 
and seals are installed as intended and the following 
tightening torques are observed: 

– Service screw: 2.5 Nm to 3 Nm (1.9 lb-ft to 2.2 lb-ft) 

The device must not be opened except via the service 
screw. 

Climatic environmental 
conditions 

Housing surface temperature: –40 °C to +70 °C 
(–40 °F to +158 °F) 

Max. 85 % humidity without condensation up to 3,000 m 
(9,842') above sea level 

Permissible vibration 
conditions 

– 2 Hz to 20.85 Hz with a maximum vibration 
displacement of 1.6 mm (0.06") 

– 20.85 Hz to 1,000 Hz with a constant acceleration of 
4g 

  
 



4 Product Description 
 

Rev. 05/2020 19 

4.1.3 Warning Notices on the Device 
  

 

Validity of warning notices on device 

The warning notices on the device are valid for the MIC100 and all 
components connected to it. 

  

Warning notice on the device German translation French translation 

WARNING! Read and 
understand the installation 
and operating manual prior to 
installing or making any 
adjustments. 

WARNUNG! Lesen und ver-
stehen Sie die Installations- 
und Betriebsanleitung vor der 
Installation und bevor Ein-
stellungen vorgenommen 
werden. 

ATTENTION! Avant d’installer 
ou d’effectuer une 
modification, lisez et 
comprenez le manuel 
d’utilisation et d’installation. 

EXPLOSION HAZARD! Do not 
disconnect while circuit is 
live unless area is known to 
be non-hazardous. For wiring 
details refer to the operating 
manual. 

EXPLOSIONSGEFAHR! Keine 
Verbindungen lösen, solange 
der Stromkreis aktiv ist, 
außer das Umfeld wird als 
nicht explosionsgefährdet 
eingestuft. Hinweise zur 
Verkabelung finden Sie in der 
Betriebsanleitung. 

RISQUE D‘EXPLOSION! Ne 
débranchez pas lorsque le 
circuit est sous tension sauf 
si la zone est connue pour 
être non dangereuse. Pour 
plus de détails de câblage, 
veuillez consulter le manuel 
d´utilisation. 

CAUTION! Do not pressure 
wash this ignition module. 
Damage to electronic 
components may result. 

ACHTUNG! Die Zündsteue-
rungseinheit nicht mit 
Hochdruck reinigen. Es 
könnte zu Schäden an den 
elektronischen Bauteilen 
führen. 

ATTENTION! Ne pas laver cette 
boîte de contrôle en utilisant 
un jet sous pression. Les 
composants électriques 
peuvent être endommagés. 

  

Warning Symbol on Device 
  

 

Warning of hot surface 
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4.1.4 Product Identification – Labeling on the Device 
The necessary numbers for unique product identification are on the device: 

– Part number of the ignition controller (P/N) 

– Arrangement number of the ignition controller (A/N) 

– Revision number of the ignition controller indicating its precise construction status (R/N) 

– Serial number of the ignition controller (S/N) 
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4.1.5 Electrical Data 
The MIC100 has the following electrical characteristics. 

Feature Value 

Power consumption Max. 40 W at 24 V 

Power supply Nominal voltage: 24 V DC 
Operating voltage: 16.8 V DC to 32 V DC  

Required current Max. current 2.0 A. An estimation of the power requirements can 
be found after this table. 

Number of outputs 4, 6 or 8 outputs 

Firing angle The size of the firing angle depends on the max. overspeed. The 
smallest ignition angle can be calculated using the following 
formula: 

 
 

Ignition frequency With full energy output (all 8 ignition outputs with 130 mJ), an 
ignition frequency of 120 Hz as continuous load is possible. With 
less ignition energy or in case of a brief overload, 133 Hz is 
possible. The maximum output load of 18 W must not be 
exceeded.  

2-stroke engine: 

 

4-stroke engine: 

 

  

Estimation of Current Requirements 
These current values are based on a nominal speed of 1800 rpm and 130 mJ energy. 

Outputs Voltage Required current 

8 24 V 1.5 A 
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Electrical Data for Inputs and Outputs 
The inputs and outputs of the ignition controller have the following electrical data: 

Inputs and outputs Values 

Analog current input Current range: 0 mA to 20 mA (adjustable in MICT) 
Input impedance: 10 Ω || 1 μF 

Binary input (Start/Stop) Wiring 

Input current: max. 20 mA 
Ignition stop: 0 V to 1 V (low level) 
Ignition release: 4.5 V to 32 V (high level)  

Go/NoGo output Implementation as bipolar power transistor 

Maximum switching voltage: 32 V DC 

Peak/steady current: max. 100 mA DC 

Output power: max. 2.5 W 

Internal resistance: 58 Ω to 60 Ω 

Activation delay: 0.5 ms / max. 100 mA load 

Deactivation delay: 0.2 ms / max. 100 mA load 

If a short is found at the output, a safety circuit, which makes 
the output highly resistive, is found at the output, so that the 
current sets itself at 50 mA to 60 mA. 

LED Three LEDs are used as status indicators. 

ASO output TTL level (5 V) 
max. current: ± 10 mA 

Pickup input Impedance: 10 kΩ 

Power supply 8 V or 15 V (configurable in MICT) 

Max. frequency for the pickup: 15 kHz 

The formula for determining the frequency of the pickups can 
be found in the note following this table. 

For a pickup output impedance of 120 Ω to 10 kΩ, the pickups 
connected to the MIC100 may not have a higher voltage than 
±40 V and the connected power may not exceed 1 W. 

Ignition coil outputs Output voltage: max. 250 V 

Output energy in normal operation mode: 130 mJ 
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Frequency of the pickups 

The frequency of the pickup is calculated as per the following formula. 

 

  
 

4.1.6 Interfaces 
Depending on the device version, the following interfaces are available: 

Service Interface 
– Compatible with MOTORTECH USB adaptor cable type1 

– The MOTORTECH USB adaptor cable type1 is only suitable for servicing and not for operation 
on the engine. 

– Max. wire length 5 m (16.4') 

CAN Bus Interface (optional) 
– Classical Extended Frame Format (CAN 2.0B) 

– As per ISO 11898 standard, 50 kbit/s to 1 Mbit/s 

– Protected against transients (automotive classification) 

– Max. 110 participants  

– Max. wire length 250 m (820') depending on the transfer rate 

  

 

Pay attention to the wiring diagrams 

Depending on the device version, certain signals or interfaces described in 
these instructions may not be available. You are also always to pay 
attention to the wiring diagrams enclosed with the input and output cable 
harnesses. 

  
 

4.1.7 Requirements for External Equipment 
External equipment shall fulfill the input and output specifications of the MIC100. 
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4.1.8 Overview Drawings 
Standard Version 
The connectors shown correspond to the standard version. Other device versions may be 
equipped with different connectors. 

 

Service Interface 
Below the service screw is the service connection, which can connect the MIC100 to a computer. 
For this purpose the special MOTORTECH USB adaptor cable type1 must be used. 
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4.1.9 LED Functions 

 

Labeling Function 

Status LED flashes green if the device is running with no errors. 
The LED flashes red if an error has occurred. 
For details, refer to the following overview. 

Firing LED lights up when the ignition is active. 

Pickup Flashing LED indicates activity of the pickups. 

  

Indication via the Status LED 
The flashing sequences shown below are repeated until the device has left the respective state 
again. However, the flashing sequences are always executed to the end and are not interrupted 
accordingly. 

The status LED flashes green: 

– Waiting for sufficient supply voltage 
Fast flashing green/off 100 ms 

        

  
– Synchronization/ Firing active 

Flashing one time green 250 ms on, 750 ms off 

        

  
– Ready for operation 

slow flashing green/off 500 ms 

        

  
– Bootloader – connection to computer started/ update mode 

Flashing one time green 2,000 ms on, 250 ms off 
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– Firing locked 
3 flashes green/off 250 ms, 750 ms off 

                

  
– Configuration/Wait for 0 RPM 

6 flashes green/off 250 ms, 750 ms off 

                          

  
  
The status LED flashes red: 

– Critical error/ Assertion 
fast flashing red/off 100 ms 

        

  
– Operating error – general/ System error 

slow flashing red/off 500 ms 

        

  
– Bootloader – faulty firmware 

Flashing one time red 2,000 ms on, 250 ms off 

        

  
– Operational error – pickup 

2 flashes red/off 250 ms, 750 ms off 

            

  
– Operational error – overspeed 

4 flashes red/off 250 ms, 750 ms off 

                    

  
– Operational error – insufficient supply voltage 

5 flashes red/off 250 ms, 750 ms off 
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The status LED flashes orange: 

– Selftest 
Flashing one time orange 250 ms on, 750 ms off 
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5.1  Unpacking 
Unpack the equipment, taking care not to damage it, and ensure that the operating manual is 
always stored with the ignition controller and is easily accessible. Check the contents for 
completeness and verify that the device type meets your application requirements. 

Scope of Supply 
The scope of supply of the MIC100 ignition controller consists of the following components: 

– Ignition controller of the MIC100 series 

– Mounting kit 

– Ground strap 

Accessory 
– MOTORTECH USB adaptor cable type1 for connecting the ignition controller to a computer 

– Operating manual 

– Software for the configuration of the ignition controller 
 

5.2  Installation of the Ignition Controller 
The installation of the MIC100 ignition controller is generally implemented on a fixed bracket 
e. g. on a wall near the engine. Use the supplied installation material and the ground strap. The 
installation location of the controller must be selected so that the distance to the pickup 
installed on the engine ensures a reliable signal transmission to the ignition controller, and so 
that there is adequate space for maintenance and repair work. The mechanical specifications 
must always be complied with (refer to Mechanical Data on page 18). 

The ground strap serves to ground the ignition controller and must be used accordingly. Ensure 
a flawless electrical connection for this purpose. 

Installation locations where strong vibrations or extreme ambient temperatures are present are 
not permissible and result in the warranty being voided. The permissible temperature range is: 

–40 °C (–40 °F) to +70 °C (+158 °F) 

  

 

Risk of destruction! 

The device may only be installed directly to or on the engine if the 
permissible vibrations and temperatures are not exceeded, otherwise 
electronic components may be destroyed. Refer to the section Mechanical 
Data on page 18. 

If vibrations are outside the permissible range, the use of rubber vibration 
dampers can have a positive effect. In case of questions, please contact 
your MOTORTECH contact person. 
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5.2.1 Installation of the Ignition Controller 
Use the supplied installation material to mount the MIC100 on a suitable bracket. The hole 
patterns can be found in section Overview Drawings on page 24. 

  

 

1. Fasten the ignition controller to the selected 
installation location. Use one bolt M8x35  
and one washer M8  for each fixing point. 

2. Insert one washer (28 mm x 3mm/1.1" x 
0.12")  between the bracket and the device 
to create the necessary distance. 

3. Secure each screw with one lock washer M8  
and one polystop nut M8 . 

▸ Fasten the ground strap to the ground pin 
(see Installation of the Ground Strap on 
page 29). 

  
 

5.2.2 Installation of the Ground Strap 
  

 

1. Fasten the ground strap  to the MIC100 
ground pin. To do so, use one washer M6 , 
one tooth lock washer A6  and one poly lock 
nut M6 . 

2. Connect the ground strap to one of the sides 
suitable for grounding. 

▸ You can wire the ignition controller as 
described in section Wiring of the Device 
on page 31. 
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5.3  Determine the Installation Location of the Pickup 
Set the position of the pickup depending on engine type and application. All angle reference 
information is based on: 

TDC 1st cylinder / compression cycle 

The installation location for the pickup must have adequate mechanical strength and must not 
exceed the specified temperature ranges. The pickup is designed for its appropriate use only. 
Multiple use of the pickup signal is not permissible. Ensure good accessibility to facilitate the 
calibration of the sensor. Comply with the pertinent regulations for the wire routing. 

For the exact positioning of the pickup, refer to the examples given in the drawings (see section 
Input Wiring – Pickup on page 35). 
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6.1  Input and Output Wiring on the Controller 
  

 

Operational safety! 

All connector screws and screw joints must be adequately tightened. 

     

 

Assignment of the wire colors 

Take the assignment of the wire colors of the wiring harness for the input 
and output wiring from the wiring diagram enclosed with the wiring 
harness. 

    

 

Pay attention to the wiring diagrams 

Depending on the device version, certain signals or interfaces described in 
these instructions may not be available. You are also always to pay 
attention to the wiring diagrams enclosed with the input and output cable 
harnesses. 

   

6 Wiring of the Device 
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19-Pole Connector for Input and Output Wiring (Standard Version) 

 

Assignment of the Connections 
  

Pin Assignment Description 

A L + Power supply 

B L – 

C Pickup Power Pickup 

D Pickup Signal 

E Pickup GND 

F Pickup Shield 

G Go/NoGo + Binary outputs 

H Go/NoGo – 

J ASO + 

K ASO – 

L Start/Stop + Binary input 

M Start/Stop – 

N Timing I in+ Analog input 

P Timing I in – 

R Shield Shield 

S CAN Hi CAN interface 

T CAN Lo 

U CAN Com 

V Not assigned – 
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6.1.1 Input Wiring – Power Supply 
      

 

Operational safety! 

The proper functioning of the device is only guaranteed if the device is 
operated within the permissible supply voltage range. Therefore, use a 
power supply in accordance with the specifications in the operating 
manual. 

       

 

Design of power supply 

For the power supply, an overcurrent protection mechanism must be set up 
with a circuit breaker (6 A DC with tripping characteristic B), which allows 
switching off. When selecting the circuit breaker, the conditions of the 
installation site and the ambient temperature must be considered. The 
circuit breaker must be easy for the user to access and marked as a 
disconnecting device for the ignition controller. 

If the power is supplied via a power supply unit, the following specifications 
must be observed additionally: 

– Voltage: 24 V DC; Current: at least 12 A 

– Wiring: at least 1 mm² cross-section 

     



6 Wiring of the Device 
 

34 Rev. 05/2020 

L ≙ 24 V DC (nominal voltage) 

 

  

Variations 

1 Battery Generator Control unit 

  

 

2   Power supply 

  

 

3   Battery Charger 
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6.1.2 Input Wiring – Pickup 
Example Configuration: 6+1 Trigger Disc, Active Pickup on the Camshaft 

 

  
The recommended distance to the triggering is 0.75 mm to 1 mm (0.03" to 0.04") for MOTORTECH 
pickups. Please note that additional fine-tuning is required for every pickup position due to the 
different conditions of the engines. 

One revolution of the pickup changes the distance as follows: 

Thread Change in distance 

M12x1 1 revolution ≙ 1 mm (0.04'') 

5/8"-18 UNF 1 revolution ≙ 1.41 mm (0.05") 

3/4"-16 UNF 1 revolution ≙ 1.59 mm (0.06") 
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Allocation of the Wire Colors (Example Configuration) 
Camshaft 

PIN Designation Wire color 

C Pickup Power Brown 

D Pickup Signal Black 

E Pickup GND Blue 

F Pickup Shield Shield 

  
For problems with the pickup signals, refer to the section Pickup Input Errors on page 108.  
  

 

Adjusting the pickup sensitivity 

Depending on the type of impulse source (interference), it may be necessary 
to increase the pickup sensitivity to ensure that the resultant signal 
strength is sufficient for reliable operation. You can make these 
adjustments in the MICT. Refer to the section Engine – Pickups – Inputs on 
page 77. 

    

 

Requirement for auxiliary supply voltage 

The auxiliary supply voltage of the pickup can be set via the MICT to 8 V or 
15 V (see Engine – Pickups – General on page 75). When an auxiliary supply 
voltage of 15 V is required, the supply voltage of the ignition controller has 
to be at least 16 V. 

    
 

6.1.3 Input Wiring – Timing and Safety Devices 
  

 

Shared auxiliary supply voltage 

Devices of the MIC100 series do not have a separate auxiliary supply 
voltage for the analog current input. For devices requiring such a voltage, 
the auxiliary supply voltage of the pickup can also be used for the current 
input. 

    

 

Requirement for auxiliary supply voltage 

The auxiliary supply voltage of the pickup can be set via the MICT to 8 V or 
15 V (see Engine – Pickups – General on page 75). When an auxiliary supply 
voltage of 15 V is required, the supply voltage of the ignition controller has 
to be at least 16 V. 
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*) See subsequent drawings for details 

X = bridge for permanent authorization 
(must be removed for external ignition 
authorization) 

  

Switch Start/Stop 

open Ignition – OFF 

closed Ignition – ON 

  

  

Two-Wire Transmitter 

 

Four-Wire Transmitter 
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Wiring MIC100 ignition controller and DetCon detonation control system 

The following diagram shows an example of the wiring of a MIC100 ignition 
controller with a DetCon detonation control system in cases where the 
analog current signal (4-20 mA) is to be used for the ignition timing 
adjustment. 

  

  

MIC100- 
ignition 
controller 

  

  

  

  

DetCon  
detonation  
control system 

  

Furthermore, the limits of the analog current input will need to be set at 
4 mA to 20 mA in the MICT. Refer to the section Timing – Analog Inputs on 
page 80. 

The timing is transmitted by MIC100 via the auxiliary synchronization 
output (ASO) to the DetCon, and will need to be wired and configured 
accordingly. Refer to the section Output Wiring – Binary Outputs (Go/NoGo, 
ASO) on page 39. 
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6.1.4 Output Wiring – Binary Outputs (Go/NoGo, ASO) 
Example Configuration 

 

  

  

  

  

*) DetCon or other external device (for wiring 
of the DetCon, see following example) 

K1 = Go/NoGo relay 

L ≙ 24 V DC 

   
Binary output as low-side switch Binary output as high-side switch 

  
(L ≙ 24 V DC)   
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DetCon connection 

Connect the ASO output on the DetCon to the connections in A and in B on 
connector Synchronization. 
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6.1.5 Output Wiring – CAN Bus Interface 
The product must be connected to a CAN bus as follows: 

  
  First device Second-to-last device 

 

    Second device Last device 

    

 

Information on protocols 

Please contact your MOTORTECH contact person if you require more 
information on the CANopen® and J1939 protocols. 
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CAN bus wiring 

Note the following when connecting the CAN bus: 

– Each bus end must be fitted with a terminating resistor of 120 Ω (see 
drawing). 

– The maximum wire length depends on the bit rate: 

Bit rate Maximum wire 
length 

Maximum length 
of a stub 

Maximum length of 
all stubs 

1 Mbit/s 25 m (82') 1.5 m (5') 7.5 m (25') 

800 kbit/s 50 m (164') 2.5 m (8') 12.5 m (41') 

500 kbit/s 100 m (328') 5.5 m (18') 27.5 m (90') 

250 kbit/s 250 m (820') 11 m (36') 55 m (180') 

125 kbit/s 500 m (1,640') 22 m (72') 110 m (360') 

50 kbit/s 1,000 m (3,280') 55 m (180') 275 m (902') 

  

– Only use cables that are specified by the manufacturer for use in the 
CAN bus. 
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6.2  Ignition Coil Wiring 
  

 

Protection when using wiring rails 

Every wiring rail on the engine block should be grounded to avoid 
disruptions in the device caused by secondary current in the ignition coils. 

    

 

Ignition coil wiring 

In the MICT there are two types of wiring with predefined output 
configuration supported in the engine database for many engines: 

– Wired in straight order 

– Wired in firing order 

For information on straight order wiring refer to Straight Order Wiring of the 
Ignition Outputs on page 45 and Engine – Parameters on page 69. 

For wiring in firing order, the first cylinder in the firing order is connected to 
the A1 output, the second to A2, etc.  

If a different wiring was implemented, the output configuration in the MICT 
must be adapted accordingly. Please note that the wiring cannot be 
checked by the software (see section Engine – Parameters on page 69). 

    

 

Conductor cross-section for primary wiring 

If you do not use a harness manufactured by MOTORTECH, the primary 
wiring must have a conductor cross-section of 1.5 mm². 
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12-Pole Output Connector 

 

Assignment of the Connections (Version with 8 Outputs) 
 

Pole Assignment 

A Output 1 

B Output 2 

C Output 3 

D Output 4 

E Output 5 

F Output 6 

G Output 7 

H Output 8 

J Not assigned 

K Not assigned 

L Not assigned 

M Ground 

 
For device versions with less ignition outputs, correspondingly less connections are assigned. 
The assignment of the connections to the existing outputs is identical. 
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6.2.1 Straight Order Wiring of the Ignition Outputs 
  

 

Risk of damage to engine 

If you use MOTORTECH wiring rails for straight order wiring, it is absolutely 
necessary that they are correctly selected and installed for the respective 
engine. Even a rotated installation can cause serious damage to the engine, 
for example. 

  
Straight order wiring, along with wiring in firing order, is supported by the MICT for many 
engines with predefined output configurations in the engine database. That means that if the 
wiring is carried out accordingly and the option Wired in Straight Order is selected in the MICT, 
no other adaptation of the output configuration is necessary. 

You can use straight order wiring, if: 

– Wiring takes place via a corresponding MOTORTECH wiring harness and a MOTORTECH 
wiring rail. The harness is marked with the following information: PLEASE NOTE! The firing 
order needs to be configured directly in the ignition controller. The ignition coils on the 
wiring rail are identified with Connector Pin 1 to Connector Pin X. 

– Make the wiring of the ignition controller corresponding to the instructions in the following 
sections (for example with an open wiring harness or via a junction box). 

Execution of straight order wiring is dependent on the following factors: 

– One or two output banks in the ignition controller 

– The type of engine (in-line or V-engine) 

– Alignment of the wiring rail(s) 
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6.2.2 Straight Order Wiring of the Ignition Outputs – Overview 
The table contains the allocation of the MIC100 outputs to the cylinders. 

Version with 8 outputs 

Pole 8 outputs In-line engine V-engine 

Connector* Coil** Connector* Coil** 

A Output A1 1 1 1 1 

B Output A2 1 2 2 1 

C Output A3 1 3 1 2 

D Output A4 1 4 2 2 

E Output A5 1 5 1 3 

F Output A6 1 6 2 3 

G Output A7 1 7 1 4 

H Output A8 1 8 2 4 

  

Connector* = connector on the wiring rail 
Coil** = ignition coil with the corresponding number on the wiring rail 

  
For device versions with less ignition outputs, correspondingly less connections are assigned. 
The assignment of the outputs to the connectors and coils is identical. 
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The ignition controllers of the MIC100 series include safety and auxiliary functions that, amongst 
others, can shut down the engine in case of fault. 

   

 

Angle indications in the operating manual 

All angles in this operating manual are given in °crankshaft. Exceptions are 
clearly identified. 

  
 

7.1  Pickup Sensitivity 
To increase the signal interference distance, the sensitivity of the pickup signal input can be 
changed for suitable pickup signal. For this purpose, a pre-trigger voltage can be set below 
which signals are interpreted as interference and are therefore not analyzed. A pre-trigger 
voltage set to a high level will thus result in a low pickup sensitivity level. 

You can enter the settings for the pickup sensitivity with the MICT. For passive pickups, you can 
set the pre-trigger voltage so that it depends on the speed. Refer to the section Engine – Pickups 
– Inputs on page 77. 
 

7.2  Monitoring of Pickup Signals 
The pickup signal is checked by the MIC100. Any other errors are displayed in the MICT. For more 
information on the errors, please refer to the overview in the section entitled Pickup Input Errors 
on page 108. 

In addition, the error is indicated on the device by the status LED flashing twice (2 times red/off 
250 ms, 750 ms off). Refer to the section LED Functions on page 25. 
 

7.3  Go/NoGo 
The binary Go/NoGo output has zero potential. It is closed during firing and opens when the 
ignition switches off. The max. switching current is 100 mA. The output can drive an external 
relay that e.g. opens a gas valve. 

The following errors can cause the ignition outputs to shut down: 

– Overspeed 

– Pickup error 

– Overload-/temperature shut-down 

– Insufficient supply voltage (Low Power) 

  

7 Functions 
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Use master control 

The outputs of the MIC100 are not SIL compliant. Therefore, always use an 
additional master control for safety-critical applications. 

  
 

7.4  Ignition Timing Adjustment 
The ignition controller has several functions for the timing correction. 

  

 

Influences on ignition timing 

Be aware that the actual ignition timing of the engine can also be influenced 
by external signals (e. g. analog current signal). 

   

 

Operational safety! 

The MIC100 ignition controller must first be correctly configured for the 
engine being used before you can start the engine. 

An incorrect configuration can result in damage to the engine. 

  

The figure below gives you an overview of the different functions of the timing correction, which 
will be explained in more detail in the subsequent sections. Functions that can be activated/ 
disabled via the MICT are marked by a switch symbol. Depending on the device version, some 
functions might not be available. 
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 Base Timing 

 

  

 Speed Curve 

  

 Analog Current Input 

  

  

 Ignition Timing Correction 

    

    

    Limited by the 
min./max. Timing 

     
 

7.4.1 Analog Current Input 
The timing point control can be adjusted with a linear current signal. This signal can be 
supplied, for example, by a potentiometer, a pressure sensor for charging pressure, or a 
detonation controller. 

With the analog process signal (current loop signal) at the analog current input, the timing point 
can be offset in the advanced or retarded direction within a defined range. 

The level of the analog current input can be set in the range from 0 mA to 20 mA. You can make 
this configuration with the MICT. Refer to the section Timing – Analog Inputs on page 80.  
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Configuration examples 

In this example the analog current input is configured in the Timing – 
Analog Inputs window as follows: 

– Lower Limit: 4 mA 

– Upper Limit: 20 mA 

Setting for the analog current input in the window Timing – Schedule A – 
General: 

– At Lower Limit (4.0 mA): 0° RET 

– At Upper Limit (20.0 mA): 15° RET 

 

  

  

  

Base timing 30° BTDC 

  

15° retarded ignition 

Setting for the analog current input in the window Timing – Schedule A – 
General: 

– At Lower Limit (4.0 mA): 0° ADV 

– At Upper Limit (20.0 mA): 15° ADV 

 

  

  

  

15° advanced ignition 

  

Base timing 15° BTDC 
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7.4.2 Speed Curve 
To optimize the ignition, for example, during the start phase of the engine, a speed curve can be 
defined for the MIC100 ignition controllers. To create this curve, up to eight adjustable speed 
points are available. 

You can configure the speed curve with the MICT. Refer to the section Timing – Schedule A – 
General on page 81. 
 

7.4.3 Ignition Timing Correction 
Via the ignition timing correction, the global ignition timing, limited by the timing limits of the 
current schedule, can be adjusted. Refer to the section Runtime Adjustments – Timing on page 
96. 
 

7.5  Firing Angles 
The min. distance between two ignition angles depends on the overspeed. The smallest ignition 
spacing can be calculated using the following formula: 

 
 

7.6  Output Monitoring 
Electronic switches are used for the ignition outputs of the MIC100 ignition controller If one of 
these switches is defective, this would lead to a primary short or a primary open output. This can 
cause problems when operating the engine or can damage the engine. The function of the 
outputs is therefore monitored and errors that occur are displayed in the runtime data in the 
MICT.  
 

7.7  ASO: Auxiliary Synchronization Output 
The ASO is an output of the MIC100 for synchronizing the MIC100 ignition controller and a 
connected control unit. The possible applications include detonation control, valve control, and 
fuel injection control. 

The first cylinder in firing order is marked with a pulse of 140 μs length. 
 

7.8  Ignition Energy 
The ignition energy provided can be limited. You can configure the ignition energy with the MICT. 
Please refer to the section Timing – Schedule A – Energy on page 82. In addition, the energy 
limit can be adjusted during operation. Refer to the section Runtime Adjustments – Energy Limit 
on page 96. 
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7.9  Access Control 
The MIC100 has four operating levels, three of which can be secured with different PINs. As a 
default setting, the access control is not activated. If the access control for the MIC100 is 
activated, it is independent from the access levels that control authorizations within the MICT.  

  

 

Access control in the MICT and on MIC100 

A user is logged in to the Advanced Service access level on the MICT. He 
changes a configuration and would like to download the change to the 
MIC100. Although he has the full authorization set in the MICT, he is 
prompted to log in with the PIN for the Level 3 (Master) on the MIC100. 

  
A variety of functions are at your disposal in the four operating levels of the MIC100 . The figure 
below illustrates this: 

 

The following functions are available on the different levels: 

– Level 0 (Read Only) 
Enables read-only access for all users. 

– Level 1 (Operator) 
The user can operate the Error Commands and the Misfire Counter on this level. 
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– Level 2 (Service) 
Only the Service level has access to modifications of the runtime adjustments for Timing and 
Energy Limit and the commands Set Engine Hours, Set Spark Plug Hours. The self-test can 
also be carried out at this operating level. 

– Level 3 (Master) 
On this level, the Master can, in addition to the other adjustments, modify the Reset Position 
and Reset All PINs and Enable/Disable Access Control. This authorization is also needed to 
transfer a configuration to an ignition controller. 

For information on the access levels in the MICT, refer to the section Access Levels in the MICT on 
page 55. 
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MICT is an abbreviation for MOTORTECH Integrated Configuration Tool. With the MICT, you can 
configure your ignition controller, and you can view and adjust the operating data of your 
engine. When working with the MICT, you can press the F1 key at any time to access context-
sensitive help. 

If you are using a different version of the MICT than shown in the following sections, the scope of 
functions may differ. 
 

8.1  MICT System Requirements 
For the installation of the MICT, the following minimum requirements must be fulfilled: 

– x86-compatible computer, at least performance class Intel Pentium 4 with 2 GHz 

– 128 MB free RAM 

– 250 MB free disk space 

– USB interface 1.1 or higher 

– Display with a resolution of at least 1440 x 900 pixels (WXGA+) 

– Microsoft® Windows 7, Windows 10 
 

8.2  MICT Installation 
The program is included on the storage device enclosed with USB adaptor cable type1. The 
adaptor cable is necessary to connect the device to a computer. In addition, you will also find all 
necessary information on the Internet at www.motortech.de. 

  

 

Installing the drivers 

Before you connect a computer with a MIC100 for the first time, it is 
necessary to install or update all necessary drivers. This driver installation 
is carried out via the MOTORTECH Driver Installer and it only needs to be 
performed once per computer: 

Install the drivers as follows: 

1. Install the drivers via the menu or directly from the storage device. 

– via the menu: 
Software -> MOTORTECH Driver Installer -> Start MOTORTECH Driver 
Installer 

– Directly from the storage device: 
Start the exe file in subdirectory Drivers(e.g. MOTORTECH-
DriverInstaller_w32.exe). 

2. Install the program. 
Follow the instructions of the installation routine. 

  

8 Settings via the MICT 
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To install the MICT, proceed as follows:  

1. Start the installation: 

– Via the menu: 
Start the file Start.exe on the storage device. Start the installation routine of the MICT 
via Software -> Install MICT. 

– Directly from the storage device: 
Start the installation routine of the MICT directly. It is on the storage device in the 
subdirectory Installation  and for example named as follows: MICT-2.40.0-setup.exe. 

2. Run the installation. 
Follow the instructions of the installation routine. Note that the license agreement terms 
must be accepted before using the MICT. 

▸ The MICT is set up. You can connect your PC to the ignition controller via the USB 
interface. 

 

8.3  Access Levels in the MICT 
You can open the MICT on your computer via Start -> Programs -> MOTORTECH -> MICT 2.x.x -> 
MICT 2.x.x. 

After opening the MICT, select the access level for which you have clearance. The access level 
controls the options you have at your disposal in the MICT. The password required for access 
can be obtained from your MOTORTECH contact person (refer to Customer Service Information on 
page 108). 

 

The following access levels are available: 

– Read Only 
On this level, the user can open a configuration and transfer it to the device. However, he 
cannot make changes to the configuration. The user has read-only access to all other 
settings. 

– Customer 
This level enables the configuration of the basic functions required for operation in addition 
to the read-only function. 



8 Settings via the MICT 
 

56 Rev. 05/2020 

– Service 
This level contains all functions for a standard installation. 

– Advanced Service 
This level offers full access to all functions of the MICT and is enabled and accessible for 
specially trained personnel only. 

The following sections describe the options at your disposal with the Advanced Service access 
level. If you have registered for a different level, you cannot execute all functions shown. 
 

8.4  Configuration Pages (Overview) 
The configuration pages are divided into the following sections: 

 

Pos. Area 

 Menu bar 

 Toolbar 

 Navigation bar 

 Configuration section 

 Status bar 
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The functions in the menu bar, navigation bar and the toolbar as well as the configuration 
section will be described in the following. 

The status bar provides you with the following information (from left to right): 

– Status display 
Indicates whether a connection is established with the device: 

– Green: Connection established 

– Red: The connection was interrupted and is being restored 

– Gray: The connection is not established and is not being restored 

– Indication of the interface being used for the connection to the device 

– Indication of the device ID 

– Indication of the access level of the user in the MICT 

– Indication of the operating level for the MIC100 if access control has been activated and the 
user has logged on with a PIN. 

– Indication of the MICT program version 
 

8.5  Menu Bar and Toolbar 
The following functions are available to you via the symbols on the toolbar and the entries in the 
menu bar: 

Symbol Menu Function 

 

File -> New Creates a new configuration. 

 

File -> Open Opens an existing configuration. 

 

File -> Save / 
File -> Save As 

Saves the current configuration. 

  File -> Recent Documents The last five configuration files used are 
offered for selection. 

  File -> Close Closes the current configuration. 

  File -> Open trace Opens a runtime data record (trace file). Refer 
to the section Runtime Data on page 85. 

  File -> Open pickup trace Opens a saved record of pickup signals 
(putrace file).  
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Symbol Menu Function 

 

File -> Change Access Level Changes the MICT access level for accessing 
the configuration data and functions. 

 

File -> Print Prints the current configuration. 

 

File -> Print To PDF File Prints the configuration to a PDF file. 

  File -> Print Preview Opens a print preview of the configuration. 

  File -> Quit Exits the MICT. 

 

Device -> Connect Connects to the device. 

 

Device -> Disconnect Cuts the connection to the device. 

 

Device -> Download to device Downloads configuration data from the 
computer to the device. Refer to Working with 
Configurations on page 64. 

 

Device-> Upload from device Uploads configuration data from the device to 
the computer. Refer to Working with 
Configurations on page 64. 

 

Device -> Runtime data Opens the window Runtime Data. Refer to the 
section Runtime Data on page 85. 

 

Device -> Log Opens the window Log (Advanced Service 
only). Refer to the section Log on page 94. 

 

Device -> Runtime adjustments Opens the window Runtime Adjustments 
(Service and Advanced Service only). Please 
refer to the section Runtime Adjustments on 
page 95. 

  Device -> Self test Opens the window Self Test (Service and 
Advanced Service only). For this refer to 
section Self Test on page 61. 

  Device-> Set spark plug operating 
hours 

Opens the window Set spark plug operating 
hours. 
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Symbol Menu Function 

  Device -> Set engine operating 
hours 

Opens the window Set Engine Operating 
Hours. 

  Device -> Send command -> Reset 
misfire counters 

The misfire counters of all ignition controller 
outputs are reset and restarted. Misfires that 
previously occurred at the outputs are no 
longer displayed. 

  Device -> Send command -> 
Acknowledge operational error 

(Keyboard shortcut: Strg+R) 

All operational errors are acknowledged. This 
can only be implemented while the engine is 
not running.  

  Device -> Access Control The setup for the access control to the MIC100 
is described in a separate section. Please read 
the section Access Control for MIC100 on page 
62. 

  Device -> Temperature Extremes Opens the window Temperature Extremes in 
which the minimum and maximum 
temperatures of the controller and output 
boards are displayed. 

  Settings -> Language Opens the window Select Language in which 
you can change the interface language of the 
MICT. 

  Settings -> Online update settings Opens the window Online Update Settings. 
Refer to the section Online Update Settings on 
page 60. 

  Settings-> Database settings Opens the window Database Settings in which 
various databases can be assigned as source 
for the MICT. 

  Settings -> Temperature scale Opens the window Select Temperature Scale, 
in which you can change the unit for the 
temperatures shown in the MICT. 

  Settings -> Display by cylinders Not currently used.  

 

Document -> Schedule Curve Opens the window Schedule. Please refer to 
the chapter Schedule Curve on page 97. 

  Tools -> Coils Opens a database with information on 
MOTORTECH ignition coils. 

  Help -> Help Opens the online help function. 

  Help -> About MICT Opens detailed information on the MICT. 
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8.6  Online Update Settings 
  

 

Perform regular online updates 

MOTORTECH is constantly expanding its databases. Perform regular online 
updates to make optimal use of the opportunities that the MIC100 provides. 

  
The MICT uses data from an engine database and a coil database for the configuration. Such 
data can be updated with automatic online updates. The settings for the update can be entered 
with the following entry in the menu bar: 

Settings -> Online update settings 

 

You have the following options: 

– Enable automatic database updates 
Using the check box, you can enable and disable automatic online updates. As the default 
setting, the online update is activated and is executed daily (if an internet connection is 
established) at first start-up of the MICT. 

– Use a proxy to access the web 
Use the checkbox to activate settings for internet access via a proxy server, which you can 
then set up by entering http-Proxy and Port. 

– Show Log 
With this button, you can open a window in which the online updates performed are logged. 

– Update Now 
With this button, you manually start an online update. 

 



8 Settings via the MICT 
 

Rev. 05/2020 61 

8.7  Self Test 
  

 

Operational safety! 

If you carry out a self test, it is essential for the gas supply to be switched 
off and no more residual gas is left in the combustion chamber. Non-
compliance can result in damage to equipment or injury to persons. 

  
You can run the self test via the MICT to check the order of the wiring and the connection 
between the ignition controller outputs and the spark plugs. 

Proceed in the MICT as follows: 

Device -> Self test 

 

The following information is provided: 

Status 
The status displays indicate whether the ignition controller is ready for the self test. 

– Locked 
The ignition controller is in a state in which no self test can be done. For example, there is an 
error or a configuration is currently being downloaded into the device. 

– Active 
The self test is running. 

– Ready 
The ignition controller is ready and the self test can be started. 
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You have the following options: 

– Cycles 
Determine whether the self test should run unlimited or be terminated after a defined 
number of cycles. 

– Outputs 
Define whether all outputs or only a defined output should be fired during the self test. 

– Cycle Time - All Configured Outputs 
Specify the cycle time either as a period or frequency. The value entered always refers to a 
complete cycle. That means that all outputs that are configured are fires once per cycle. If 
you only set one output for the self test, this would still only fire once per cycle. 

– Control 
Start or stop a self test using the corresponding buttons. 

 

8.8  Access Control for MIC100 
If the access control to the MIC100 is activated, access to the following areas is possible with a 
PIN only: 

– Runtime Adjustment (Reset, timing and energy limit) 

– Commands (Error commands, set engine/spark plug operating hours and self test). 

– Configuration (Transferring a configuration to the MIC100) 

The access control regulates the accesses to the device via the MICT. For explanations 
concerning access control of the MIC100 and the delimitation of the access levels in the MICT, 
refer to section Access Control on page 52. 

The access control functions can be accessed in the menu bar via: 

Device -> Access Control 
 

8.8.1 Enable/Disable Access Control 
   

 

Enable/Disable access control 

As a default setting, the access control is not activated, and all PINs are set 
to 0000. Once the access control has been activated, and the PINs were 
changed, these PINs will continue to be used. To activate the access control 
again, you will need the PIN for level 3 (Master). It is therefore 
recommended to reset all PINs before disabling. 

If that was not done, or a system must be unlocked for another reason, a 
request key can be issued in the MICT. Refer to the section Reset all PINs on 
page 64. 
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To enable or disable the access control, proceed as follows: 

1. Open the input dialog via Device -> Access Control -> Enable or Disable access control. 

2. Enter the PIN for the level Master (Level 3). 

3. Confirm the input with OK. 
 

8.8.2 Login/Logout 
If the access control is activated, you are prompted to log in if you want to execute functions that 
are allocated to a specific operating level. In addition, you can log in specifically to an operating 
level via the menu bar. 

To log into a specific operating level, proceed as follows: 

1. Open the input dialog via Device-> Access Control -> Login. 

2. First select the level you wish to log on to. 

3. Enter the PIN for the desired level. 

4. Confirm the input with OK. 

▸ You are now logged into the corresponding level and can execute all functions that are 
allocated to this operating level without having to log in again. 

After completing the log-in, you can log out again as follows: 

Device -> Access Control -> Logout 
 

8.8.3 Changing the PIN 
To change the PIN for a specific operating level, proceed as follows: 

1. Open the input dialog via Device -> Access Control -> Change PIN. 

2. First select the level for which you wish to change the PIN. 

3. Enter the current PIN for the desired level. 

4. Enter the new PIN in the two subsequent fields. 

5. Confirm the input with OK. 

▸ The PIN for this operating level has now been changed. 
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8.8.4 Reset all PINs 
To reset all PINs, proceed as follows: 

1. Open the input dialog via Device -> Access Control -> Reset all PINs. 

2. If you are not yet logged into the Master (level 3) level, you will be prompted to log in with 
the relevant PIN. 

3. Confirm the input with OK. 

4. To reset all PINs, you will be prompted again to enter the PIN for the level Master (Level 3). 

5. Confirm the input with OK. 

▸ All PINs are now reset to the value 0000. 

To reset all PINs, you need the PIN for the level Master (level 3). To be able to unlock a system in 
case of emergency that was locked in this way, you have the following option: 

1. In the menu bar, select the entry Device -> Access Control -> Get reset all PINs request key to 
open a window with the same name. 

2. Send the request key with the serial number to your service contact person at MOTORTECH 
(refer to Customer Service Information on page 108). This key is valid only for the respective 
controller and only for a certain amount of time. 

▸ Your information will be verified, and you will receive an authorization key from your 
contact person. 

3. From the menu bar, select the entry Device -> Access Control -> Set reset all PINs 
authorization key to open a window with this name. 

4. Enter the authorization key received in the input field. 

5. Confirm the input with OK. 

▸ If the input was correct, all PINs are reset to the default value 0000. 
 

8.9  Working with Configurations 
To ensure that the MIC100 correctly interprets incoming data and correctly controls the ignition 
system, it requires information about the engine and the ignition system. This information is 
stored in the MIC100 as configuration data. 

You can use the MICT to perform the following for these configurations: 

– Create 

– Open 

– Edit 

– Save as a file 

– Download to the MIC100 

– Upload from the MIC100 
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8.9.1 Create, Open, Save 

 

Click on the symbol to create a new configuration and select the corresponding 
device type. The device type corresponds to the first five digits of the 
arrangement number, which you can find on a label on your device. 

 

 

Click on the symbol to open a saved configuration. 

 

 

Click on the symbol to save the configuration currently displayed in the MICT to 
a storage device. 
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Compatibility of the configuration files 

Configuration files are only compatible for the respective device type, even 
if the file extension is identical. For example, files created for a MIC3 cannot 
be downloaded to a MIC3+ and vice versa. 

To use a configuration for another device, the series and the first four digits 
of the arrangement number must match. This information can be found in 
the title bar of the configuration and on the respective device: 

MIC3 

 

 

MIC3+ 

 

 

If, for example, a system is to be changed from a MIC3 to a MIC3+, the 
configuration of the MIC3 can be saved as a PDF file. Then a new 
configuration file must be created for the MIC3+ and the values from the 
PDF file must be entered. Alternatively, the MICT can be opened twice and 
the values transferred to a newly created configuration file. 

 

  
 

8.9.2 Upload, Download 

 

Click the symbol to upload the current configuration from the MIC100 to the 
MICT. If applicable, the MICT first establishes a connection to the MIC100 
connected. 

 

Click on the symbol to download the configuration set in the MICT to the 
MIC100. This function can only be executed while the ignition is not active. This 
action overwrites the existing configuration on the device. If applicable, the 
MICT first establishes a connection to the MIC100 connected. 
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Existing configuration is cleared! 

If you download a configuration to a MIC100, the previous configuration is 
deleted and the new settings are immediately implemented. 

    

 

Runtime adjustments 

If you change a configuration stored in the MIC100 via runtime adjustments, 
the configuration must be re-uploaded from the device so that the changes 
are displayed in the MICT's configuration views. 

  
 

8.9.3 Compatibility Information 

 

If you upload a configuration from the MIC100 to the MICT that does not correspond to the status 
of your MICT, or if you open this type of configuration in the MICT, the following situations may 
occur: 

– No values are present in the configuration for certain MICT functions. The MICT assumes the 
standard values for these functions. 

– The configuration contains function values that are not support by the MICT. 

The following situations can occur if you download a configuration from the MICT to a MIC100 
whose firmware does not correspond to the status of your MICT: 

– No values are present in the configuration for certain firmware functions. The firmware 
continues to use the preset values for these functions. 

– The configuration contains function values that are not support by the firmware. 

If you download a configuration into the MIC100 and are notified of functions that are not 
supported by the MICT, you should check the MIC100 settings. Re-upload the configuration from 
the MIC100 to the MICT. You can then see which settings are not transmitted to the MICT. 

Perform a firmware update, if necessary, and/or update your MICT so that you can use all the 
MIC100 functions without restriction. 
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8.10  Configuration 
The window opens after you select the device type for a new configuration or an existing 
configuration or have uploaded one from the ignition controller. You can make changes to the 
configuration by selecting an entry from the navigation bar. The corresponding configuration 
data are then displayed in the configuration section and can be processed. The following 
sections will describe the settings and adjustments you can implement in the different areas. 

  

 

Indication of invalid entries 

An invalid selection or invalid input values are highlighted by pulsating 
warning signs on the configuration pages of the MICT. Additional 
information is provided in the status bar. 

Example: 
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8.10.1 Engine – Parameters 

 

Engine Selection 
The MICT holds an engine database with data from various manufacturers and model series. 
Select the desired engine manufacturer, series, and type by clicking on the corresponding fields. 
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Wiring in firing order is assumed as standard. If straight order wiring is supported for the 
selected engine, the Wiring dialog opens and you have the opportunity to adapt the output 
configuration. 

 

You can use straight order wiring, if: 

– Wiring takes place via a corresponding MOTORTECH wiring harness and a MOTORTECH 
wiring rail. The harness is marked with the following information: PLEASE NOTE! The firing 
order needs to be configured directly in the ignition controller. The ignition coils on the 
wiring rail are marked with Connector Pin 1 to Connector Pin X. The position of coil1 on the 
wiring rail is marked in the view Wiring. 

– Wiring of the ignition controller is done corresponding to the instructions in section Straight 
Order Wiring of the Ignition Outputs on page 45 (for example with an open wiring harness or 
via a junction box). 

The configuration of the ignition outputs is automatically adapted corresponding to your 
selection. If you want to use a different wiring, these settings must be adapted appropriately. 

If the pertinent engine is not available in the database, settings can also be entered by selecting 
the corresponding sequence. For this purpose, click on the entry Sequence in the column Engine 
Manufacturer and select the firing stroke in the column Series, then the number of cylinders, 
and the ignition offset of the engine as needed. After making your selections, the right hand 
section Engine Information will display a summary of the parameters selected. 

The summarized data are transferred to the subsequent configuration page Ignition Outputs. 
The values displayed there can only be changed by users with authorization to access the 
Advanced Service level. 
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Engine database 

MOTORTECH does not assume liability for the information in the engine 
database. Please contact MOTORTECH if discrepancies are found. 

  

New Engine Configuration 
Staff with the authorization for the Advanced Service level additionally has the option for 
entering the engine data manually, i.e., without selecting entries from the engine database. For 
this purpose, click on the button New Engine Configuration and select the number of cycles in 
the dialog box opening up. Additional information can be entered on the configuration page 
Ignition Outputs. 
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8.10.2 Engine – Ignition Outputs 

 

Make adjustments to the following settings as needed: 

– Number of Outputs 
Select the number of outputs for the respective output board. 

– Column: Output 
Select the number of the respective output. 

– Column: Angle 
Enter the firing angle for each output. 

Default Application 
If you select from the engine database, the data stored for the selected configuration are 
displayed. These data can only be changed by personnel with access to the Advanced Service 
level. 

New Engine Configuration 
Selecting the Nr. of Outputs enables access to the fields for the configuration of the outputs. By 
default, the ignition outputs are distributed so that cylinder 1 of the ignition sequence is always 
allocated an ignition angle of 0°. The ignition angle for each output results from the addition of 
the ignition spacing to the respective previous output. 
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Operational safety! 

Never connect more than one output to each ignition coil, as the output 
board can otherwise be damaged. 

  
The allocation of outputs on the output banks to contacts of the output connector of the device 
and the cylinders is determined by the wiring. The user must take the wiring into account during 
the configuration; it cannot be checked by the software. 

  

 

Interval between two ignitions 

The interval between two ignitions must be at least 1 ms. During the check, 
the configured overspeed is used in the calculation. 

  
 

8.10.3 Engine – Ignition Coils 
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Ignition Coil Type 
Select the ignition coil type from the drop-down list. (Without this selection the configuration 
cannot be downloaded to the MIC100.) 

  

 

Only use measured ignition coils 

To operate the MIC100, only ignition coil types measured by MOTORTECH 
may be used. All ignition coils used must correspond to the part number 
selected in the drop-down list. Different coil types must not be mixed and 
also no equivalent or replacement types may be used. 

If a coil type used is not in the drop-down list, then the MIC100 is currently 
not used. 

  
 

8.10.4 Engine – Speed Settings 

 

Ignition Release 
Enter the release speed for the ignition at which the first ignition is to fire. The value shall not 
exceed 1/7 of the nominal speed. 
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Security Speed 
Enter the security speed (max. half the nominal speed). Below the value entered, the ignition can 
be switched on and off as desired. If the ignition is deactivated during operation above the set 
speed, the ignition cannot be immediately reactivated. Only when the ignition no longer reads a 
speed, i.e., the engine has come to a standstill, can the ignition be reactivated. 

Nominal Speed 
Enter the nominal speed at which your engine is to be operated. With engines that are to be 
operated with variable speeds, the max. speed of the operating range must be entered. 

Overspeed 
Enter the speed at which the ignition is to be shut off as overspeed protection. With engines that 
are to be operated with variable speeds, a speed above the operating range must be entered.  

Max. Power-on Speed 
Enter the maximum permitted start speed at which the MIC100 starts sending ignition pulses. 
A value of 6000 rpm is set as the default value: The MIC100 can be activated at the starter speed 
and immediately send ignition pulses. 
For a value of 0 rpm the MIC100 can only start sending ignition pulses once it has registered that 
the engine is at a standstill. 
 

8.10.5 Engine – Pickups – General 
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Active pickups 

Check when using active pickups that the auxiliary supply voltage is 
configured for your application. 

  
Index/Reset Position 
Enter the distance between the first event after the set index/ reset marking and top dead 
center. With the button Adjust, you can enter the measured firing angle for a given nominal 
value. The system calculates the difference from these values, which is added to or subtracted 
from the index/reset position. 

Aux. Pickup Supply Voltage 
Select the supply voltage with which the active pickup is to be operated. 8 V or 15 V are possible. 
When an auxiliary supply voltage of 15 V is required, the supply voltage of the ignition controller 
has to be at least 16 V. 

  

 

Shared auxiliary supply voltage 

Devices of the MIC100 series do not have a separate auxiliary supply 
voltage for the analog current input. For devices requiring such a voltage, 
the auxiliary supply voltage of the pickup can also be used for the current 
input. 
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8.10.6 Engine – Pickups – Inputs 

 

Type 
You can select the type of events that will occur on this input for each pickup input. Type and 
number of events are defined by the discs or ring gears used. If you decide not to use a pickup 
input, select the entry None from the list. The following types can be set: 

– N+1 
Disc of type N with one additional event, e.g. a disc with 6 teeth and one additional tooth for 
the index signal (N=6). 

– N+1 Extended Index Range 
Disc of type N with one additional event, e.g. a disc with 6 teeth and one additional tooth for 
the index signal (N=6). The permitted range for the index signal is expanded to 75 % of the 
tooth period. An incorrect direction of rotation of the engine cannot be detected by this 
setting. 

– N-1 
Disc of type N where one event is missing, e.g. a ring gear with 160 teeth on which one tooth 
was removed (N=160). This missing event is used to determine the index signal. 

– N-2 
Disc of type N, where two consecutive events are missing, e.g. a ring gear with 160 teeth on 
which two teeth located next to each other were removed (N=160). These missing events are 
used to determine the index signal. 
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Number of Events 
Enter the number of events that occur on the pickup if more than one event is expected. Enter 
the value for N and not the total number of events for the selected pickup type. 
The number of events depends on the selected pickup type. 

– N+1 and N+1 extended index range: Values between two and eight 

– N-1 and N-2: Values between 30 and 240 

Active/Passive 
Select the pickup to be used from the pre-defined pick list: 

– Passive 
passive pickup 

– Active (low) 
active pickup with high level as quiescent level 

– Active (high) 
active pickup with low level as quiescent level 

Speed 
 For passive pickups, you can set the pre-trigger voltage so that it depends on the speed. See 
also the following example. 

Pre-Trigger 
Enter a value between 0.5 V and 7.5 V for each pickup to set the pickup sensitivity level. Signals 
that fall short of the set voltage will not be analyzed. A low pre-set value therefore results in a 
high sensitivity level, a high value results in a low sensitivity level. 
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Speed-dependent pre-trigger voltage 

For a passive pickup, the pre-trigger voltage is defined as follows: 

– Speed1: 150 RPM; Pre-trigger voltage1: 2 V 

– Speed2: 1000 RPM; Pre-trigger voltage2: 5 V 

The result is the following curve: 

  
Pre-trigger voltage 
(V) 

  

 

  
  
  
  
  
  
Speed 
(RPM) 
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8.10.7 Timing – Analog Inputs 

 

Analog Inputs Base Settings 
The ignition timing can be adjusted via an analog current signal, which can be set within the 
limits of 0 mA to 20 mA. 

Set the Upper Limit and Lower Limit of the signals corresponding to your connected device. Also, 
you have the option to enter a Failure Threshold. If the signal does not reach this value, it is 
classified by the ignition controller as failure (e.g. wire break). The error value configured in the 
schedule was set for the affected input. To reset the error state, a threshold will need to be 
exceeded. This threshold value is calculated as follows:  
Threshold to reset the error state ≥ 0.5 x (Lower Limit - Failure Threshold) + Failure Threshold 

In the schedule you define which ignition timing adjustment results from the analog signal. 
Refer to the section Timing – Schedule A – General on page 81. 
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8.10.8 Timing – Schedule A – General 

 

Limits 
Enter the limits of the timing point at which the ignition can fire. The timing points of the outputs 
will be limited to this range relative to the respective top dead center of the pertinent cylinder. 
The global timing can then not be shifted beyond this range by any adjustments. 

Base Timing 
Enter the timing specified by the engine manufacturer. This point must be within the limits 
entered and is a static portion of the global timing. 

Analog Current Input 
The analog current input can be enabled and disabled by clicking. Enter the values by which the 
adjustment is to be implemented for the corresponding input signal. An error value can be 
entered for the signals if a failure threshold has been defined for the corresponding input in the 
window Timing – Analog Inputs. If the signal is below the failure threshold, the timing is offset 
by the error value. The adjustment remains until the signal again exceeds the threshold to reset 
the error state (see Timing – Analog Inputs on page 80). 
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Speed Curve 
The speed curve can be activated and disabled by mouse click and offsets the timing depending 
on the speed. A max. of eight speed points are available. If you select a number of points from 
the list, the corresponding number of fields is activated for input. 

The first speed point is always set to 0 RPM. All other timing points are assigned with the value 
by which the signal is to be offset when the respective speed is reached. For the last speed 
point, the timing of the nominal speed should be entered. Please note that the speed points 
must always be entered in ascending order. 
 

8.10.9 Timing – Schedule A – Energy 

 

Energy Limit 
You can use the field Energy Limit to limit the output energy made available by the ignition 
controller. The energy limit is adjustable from 80 mJ to 130 mJ. 
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8.10.10 Miscellaneous – Communication 

 

CAN1 
Clicking on the checkbox CAN1 enables or disables the CAN interface on the device. 

– J1939/CANopen 
Select the desired protocol depending on the device you want to communicate with. For the 
ALL-IN-ONE gas communication use J1939.  

– J1939 Settings 
The J1939 source address can be assigned between 0 and 253. Note that IDs cannot be 
assigned more than once.  

– CANopen Settings 
The CANopen node ID can be assigned between 1 and 127. Note that IDs cannot be assigned 
more than once. 

– Baudrate 
Select the desired data transfer rate from the list. The baud rate can be defined between 
50 kbit/s and 1 Mbit/s, the recommended value being 250 kbit/s. 
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Setting the transfer rate 

Please note that all devices connected with a bus must be set to the same 
transfer rate. 

     

 

Information on protocols 

Please contact your MOTORTECH contact person if you require more 
information on the CANopen® and J1939 protocols. 

    
 

8.10.11 Miscellaneous – Information 
This configuration page can be viewed by all users, but changes can only be made with 
authorization for the Service access level. 
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Site and Module 
In this section, enter information on the system and the module for which the configuration will 
be used. 

Service Contact 
In this section, individual contact data can be saved that can be called up and displayed via 
MICT. 
 

8.11  Runtime Data 

 

Click on the symbol to open the window Runtime Data. The following sections will give 
you an overview of the data you can view on the individual tabs. 

You can print and record the runtime data. For this purpose, the following functions are at your 
disposal in the toolbar in the window: 

Symbol Function 

 

Prints the runtime data. 

 

Prints the runtime data to a PDF file. 

 

Opens the print preview. 

 

Starts the runtime data trace. 

 

Stops the runtime data trace. 

 

Acknowledges the operational errors. The symbol is grayed out if no 
acknowledged error is present. 

   

 

Save runtime data locally 

You should always save runtime data on the local computer and not on a 
network drive or external storage device. Trace files can only be moved 
freely once the recording is stopped. 
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8.11.1 Runtime Data – Overview 

 

In this screen, you can find the following information: 

– Speed Indicator (analog) 

– Red pointer 
Displays the current registered speed 

– Yellow pointer 
Displays the maximum registered speed since last starting the engine 

– Green pointer 
Display of set overspeed  

– Speed Indicator (digital) 
Digitally displays the current speed 

– Global Timing Point 
Digital indication of the current global timing 
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– Operating Hours 

– Spark Plugs 
Indicates the current operating hours of the spark plugs 

– Engine 
Indication of current operating hours of the engine 

– Device State 
The status of the device is shown by the following status displays: 

  

Device status Description 

Idle The ignition is ready and waiting for pickup activity. 

Synchronizing Pickup signals are being received and analyzed. 

Firing Active The ignition is active. 

Firing Locked Pickup signals are being received and are valid, ignition is 
not released. 

Wait for Stop Pickup signals are being received, the ignition fired above 
the security speed, and the ignition release was retracted. 
The engine must now come to a standstill. 

Configuration The device is being configured. 

Self Test The self test is running (refer to Self Test on page 61). 

Warning A warning has occurred. 

Error An error has occurred. 

   

– Control 

– Firing Enabled 
The green status display signals that the firing is active. 

– Errors 

– Analog Current Input 
The red status display signals that the set failure threshold for the input has been 
reached. If the lower limit of the signal is reached again, the status display is again 
gray. 

– Ignition Output 
The red status display signals a current misfire on at least one output. With a yellow 
status display at least one misfire has occurred at one output since the last reset of the 
counter. 

– Misfire Rate 
The misfire rate is displayed for the primary side. 
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– Single Output 
Displays the misfire rate of the output for which the most misfires were registered 
during the last 32 cycles. 

– All Outputs 
Displays the misfire rate for all the ignition outputs for the past 32 cycles. 

– The number of misfires per second are calculated by the MIC100 as follows: 
2-stroke engine: Number of currently misfiring outputs x RPM / 60 
4-stroke engine: Number of currently misfiring outputs x RPM / 60 / 2 

 

8.11.2 Runtime Data – Timing 

 

In this view, the system displays all values and settings in the left hand section that influence 
the timing. In the right hand section, the value is additionally displayed and shown as a bar 
chart, which is measured at the analog current input and thus causes the change to the timing 
shown.  

The value for the speed curve is shown by curve progression set in the configuration. Refer to the 
section Timing – Schedule A – General on page 81. The timing correction can be implemented for 
the runtime. Refer to the section Runtime Adjustments – Timing on page 96. 
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8.11.3 Runtime Data – Bank A 

 

In this screen, you can find the following information: 

– Column: Output 
Designation of the output 

– Column: Angle 
Current output firing angle 

– Column: Min. Spark Duration 
Minimum spark duration of the outputs 

– Column: Energy Output 
Current energy release of the output 
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– Columns: Misfire 
Status display for the different types of misfires (primary, open, short circuit). In case of 
misfire, the respective status display turns red, otherwise it is gray. With a yellow status 
display misfires have occurred since the last reset of the counter.  
If you hold the pointer over the status display, an overview of the misfire counter of the 
respective output is displayed for all types of misfires. A maximum up to 255 is counted per 
type of misfire. The counter manually resets using the menu item Device-> Send command -> 
Reset misfire counters. When starting the engine and starting the self test the counters are 
automatically reset. 

 

8.11.4 Runtime Data – States 
No states are currently displayed in the window. 
 

8.11.5 Runtime Data – Message Log 
No messages are currently displayed in the window. 
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8.11.6 Runtime Data – Diagnostics 

 

In this screen, you can find the following information: 

– CAN State 
The status display indicates the current error handling status of the device for the CAN bus 
communication: 

– Error Active 
The device is in normal status of the bus communication. If an error occurs in the 
communication, the device sends an active error flag. 

– Error Passive 
After a defined number of errors in the bus communication, the device changes to the 
status Error Passive. If another error occurs, the device sends a passive error flag. 

– Bus Off 
The device is disconnected from the CAN bus due to error accumulations in the bus 
communication. 
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– Controller Board 

– Supply Voltage 
Current voltage supply of the controller board. 

– Pickup Input 1 Pre-Trigger Voltage 
Current pre-trigger voltage for the pickup inputs (refer to Engine – Pickups – Inputs on 
page 77). During operation the pre-trigger voltage for passive pickups is increased 
depending on the speed, so that the ignition controller is less prone to interferences. 

– Output Board 

– Power Output 
Current output of the output board 

 

8.11.7 Runtime Data – Temperatures 

 

In the window you receive an overview of the temperatures of the controller board. The maximum 
and minimum values are reset at each new start of the ignition controller. 
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The following information is provided: 

– Controller Board 

– Current Temp. 
Current temperature of the controller board 

– Min. Temp. 
Minimum measured temperature of the controller board 

– Max. Temp. 
Maximum measured temperature of the controller board 

 

8.11.8 Runtime Data – Information 

 

In this view, you can find an overview of the device and version data. If problems arise, you can 
print the current runtime data and send them to the MOTORTECH Service Department by fax or as 
a PDF file by email. For fast support, we will then immediately have all required information. 
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8.12  Log 

 

Click on the symbol to open the window Log. This window is only available to 
users with authorizations starting at the access level Advanced Service. 

 

The window Log serves to support error diagnostics by MOTORTECH.  

– Automatic scrolling 
If the function is active, the view panel focuses on the latest message. 

– Log level 
The selection of the log level is specified by MOTORTECH if needed. 

– Write log to file 
This checkbox activates or deactivates, respectively, the saving of the logged data in a 
selected file. If the function is disabled, the logged data are merely shown on the display. 

– Select file 
With this button, you can select a file to which you want to save the logged data. 

If you are prompted to create a log file in the case of a service request, proceed as follows: 

1. Open the window Log via the toolbar or the menu bar. 

2. Select a path with the Select file button and enter the file name for the log file. 

▸ If the file does not yet exist, it is automatically created with the extension .log. 

3. Activate the checkbox Write log to file. 
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4. Select the level specified by MOTORTECH from the list Log level. 

5. Leave the window open. 

▸ The log messages are logged both in the window and in the selected file. 
 

8.13  Runtime Adjustments 

 

Click on the symbol to open the window Runtime Adjustments. This window is 
only available to users with authorizations starting with access level Service. 

  

 

Runtime adjustments are implemented directly 

All runtime adjustments are implemented directly without requiring the 
input to be confirmed. 

  
 

8.13.1 Runtime Adjustments – Reset 

 

The index/reset position can be corrected by 5 °crankshaft (advanced/retarded) while the device 
is being operated. The correction is made with the buttons: 

– 0.1 ADV/RET 
in 0.1° increments to advance or retard 

– 0.5 ADV/RET 
in 0.5° increments to advance or retard 

Changes are implemented immediately and stored in the configuration provided in the device. 

If the correction range is not sufficient, the reset/index position must be adjusted in the 
configuration (refer to Engine – Pickups – General on page 75). 
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8.13.2 Runtime Adjustments – Timing 

 

The global ignition timing position can be corrected by 50 °crankshaft (advanced/retarded) 
while the device is being operated. The correction is made with the buttons: 

– 0.1 ADV/RET 
in 0.1° increments to advance or retard 

– 0.5 ADV/RET 
in 0.5° increments to advance or retard 

The limit for the ignition timing set in the schedule (refer to Timing – Schedule A – General on 
page 81) cannot be exceeded or not reached with the runtime adjustment. 

The correction of the global ignition timing is immediately implemented and also remains in 
place if the device is restarted. NOTICE: The configuration defined in the device is not changed. 
 

8.13.3 Runtime Adjustments – Energy Limit 

   

The energy limit can be adjusted in the range 80 mJ to 130 mJ during operation of the device. The 
adjustment is made with the buttons: 

– -/+ 1 
in 1 mJ steps  

– -/+ 10 
in 10 mJ steps  

Changes are implemented immediately and stored in the configuration provided in the device. 
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8.14  Schedule Curve 

 

Click on the symbol to open the window Schedule. 

  
 

8.14.1 Schedule Curve – Simulation 

 

The schedule curve visualizes the configurations of the schedule and simulates the influence of 
the analog current input over the speed range. Changes made by turning the control button or 
entering the desired value are displayed simultaneously. 

– Simulation 
The simulation is activated or disabled using the checkbox. 

– Analog Current Input 
Simulation of the analog current input 

– Control button for adjustments between the configured values (e.g. 0 mA and 20 mA) 

– Field for manual input of the desired value in mA 

– Displays the value in °crankshaft by which the timing is offset 
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– Timing Point 
Displays the global ignition timing as it changes during the simulation. 

While connected to the device, the ignition timing is simulated depending on the actual engine 
speed and marked as  in the diagram. 
 

8.14.2 Schedule Curve – Runtime Values 
If the checkbox Simulation is unchecked, the Schedule curve window switches to the current 
runtime data. 

 

In this screen, you can find the following information: 

– Analog Current Input 
Left column:  
Display of the newly calculated adjustment value of the current input 
Right column:  
Display of the values of the current input supplied by the ignition control unit 
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– Speed 
Display of the current speed 

– Timing Point 
Displays the current global ignition timing. 

 

8.15  Coils 
The MICT has a database with technical information on MOTORTECH ignition coils. Open the 
database as follows: 

Tools -> Coils 

You have the option of storing and printing information on the ignition coils present in the 
database. For this purpose, the following functions are at your disposal in the toolbar in the 
Coils window. 

Symbol Function 

 

Stores the information on the selected ignition coil in a format that is 
appropriate for configuring the MIC100 via fieldbus. 

 

Prints the selected coil data set. 

 

Prints the selected coil data set as PDF file. 

 

Opens the print preview. 

Coils 
– Device 

Select an ignition controller. 

– Coil 
Select an ignition coil. 

  

 

Select the correct ignition controller 

The ignition coil data depends on the ignition controller used. Always select 
the ignition controller for which you are using the coils in order to obtain 
the correct data. 
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8.15.1 General 

 

Details 
The following information is provided: 

– Name 
Coil name 

– Coil Type ID 
Used to clearly identify the ignition coil 

– Data Version 
Shows data version of the ignition coil selected in the database. The data version of the 
ignition coil configured in the ignition controller is displayed in the runtime data in the view 
Information (refer to Runtime Data – Information on page 93). The Automatic Online Update 
should be activated to ensure that the coil database always has the latest data sets. 
Additional information on the online update is provided in the section Online Update 
Settings on page 60. 

– Illustration of the ignition coil 
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Coil Parameters 
The following information is provided: 

– Energy Limit [mJ] 
Displays the permitted value range for the energy limit in mJ. The energy limit is configured 
in the view Timing – Schedule A – Energy (refer to Timing – Schedule A – Energy on page 82). 
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9.1  Start-up 
Before you start up the MIC100 ignition controller, take note of the following:  

– Were the correct engine, ignition sequence, and output configuration selected? If you are 
unsure, contact MOTORTECH or the corresponding engine manufacturer. 

– Ensure that the firing order of the engine and/or the wiring of the output cable harness are 
carried out correctly. 

– Is the wiring of the pickup compliant with the drawings given in this operating manual? 

– Is the distances of the pickup to trigger discs, reluctor pins, etc. correctly set (see chapter 
Determine the Installation Location of the Pickup on page 30)? 

– Ensure that the data were transferred flawlessly to the controller. 

– Check whether the start/stop input is set to Firing Active, or whether it works according to 
the control requirements of the master control. 

– Close the service screw after completing the installation and configuration. 

– Ensure that no gas is present in the inlet and exhaust systems before you start the engine. 

– Ensure that the gas valve is closed. 

– Perform the normal engine start-up process while the gas valve is closed (start only). 

– Connect a stroboscope to the first firing cylinder (cylinder #1) and check whether the timing 
point set on the ignition controller coincides with the actual timing point on the crankshaft. 
If the ignition timing does not coincide exactly, change it (see chapter Runtime Data on 
page 85) until the optimal setting is reached.  

– Check all other cylinders for correct ignition. If they are not correct, stop the engine, and 
recheck wiring and ignition sequence for correctness. 

 

9.2  Shutdown 
The ignition controller is shut down by disconnecting it from the power supply. 
 

9.3  Firmware Update 
Using the MOTORTECH Flash Tool, you can update the firmware of the ignition controller. The 
program is included on the storage device enclosed with USB adaptor cable type1. The adaptor 
cable is necessary to connect the device to a computer. In addition, you will also find all 
necessary information on the Internet at www.motortech.de. 

Basically, the same system requirements apply to the MOTORTECH Flash Tool as to the MICT. 
Refer to the section MICT System Requirements on page 54. 

9 Operation 
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Install MOTORTECH Flash Tool 
  

 

Installing the drivers 

Before you connect a computer with a MIC100 for the first time, it is 
necessary to install or update all necessary drivers. This driver installation 
is carried out via the MOTORTECH Driver Installer and it only needs to be 
performed once per computer: 

Install the drivers as follows: 

1. Install the drivers via the menu or directly from the storage device. 

– via the menu: 
Software -> MOTORTECH Driver Installer -> Start MOTORTECH Driver 
Installer 

– Directly from the storage device: 
Start the exe file in subdirectory Drivers(e.g. MOTORTECH-
DriverInstaller_w32.exe). 

2. Install the program. 
Follow the instructions of the installation routine. 

  
Install the MOTORTECH Flash Tool as follows: 

1. Start the installation: 

– Via the menu: 
Start the file Start.exe on the storage device. Start the installation routine for the 
MOTORTECH Flash Tool via Software -> MOTORTECH Flash Tool -> Install MOTORTECH 
Flash Tool. 

– Directly from the storage device: 
Start the installation routine of the MOTORTECH Flash Tool directly. It is on the storage 
device in the subdirectory Installation  and for example named as follows: MOTORTECH-
Flash-Tool-0.9.00003-setup.exe. 

2. Install the program. 
Follow the instructions of the installation routine. Note that the license agreement terms 
must be accepted before using the MOTORTECH Flash Tool. 

▸ The MOTORTECH Flash Tool is set up. You can now connect your computer to the ignition 
controller via the USB interface. 
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Menu Bar and Toolbar 
After launching the MOTORTECH Flash Tool, the following functions are available to you via the 
icons on the toolbar and the entries in the menu bar: 

Symbol Menu Function 

 

File -> Open Opens a firmware file. 

  File -> Quit Exits the program. 

  View -> Extended file information 
view 

Fades in / out additional information of the 
firmware file. 

  View -> Extended connection 
settings 

Fades in / out additional information and 
settings of the connection to the device. 

 

View -> Reload file Reloads the file information of the selected 
firmware file. 

 

Device -> Search devices Restarts the search for connected devices. 

 

Device -> Flash device Starts the update process or downgrade 
process. 

  Settings -> Language Opens the window Select Language in 
which you can change the interface 
language of the program. 

  Help -> Help Opens the online help function. 

  Help -> About MOTORTECH Flash 
Tool 

Opens detailed information on the 
program. 

  

Start Firmware Update 
  

 

Access control for firmware update 

If you have activated the access control for the ignition controller, you need 
the PIN for the level Master for the firmware update. For more information 
read the section Access Control for MIC100 on page 62. 
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Backup the existing configuration 

Your device's configuration may be lost if the firmware update is not 
performed properly. Always backup the existing configuration via the MICT 
prior to performing an update. For more information read the section 
Working with Configurations on page 64. 

  
To start a firmware update, proceed as follows: 

1. If an MICT is connected with the ignition controller, disconnect this connection. 

2. Start the MOTORTECH Flash Tool via Start -> Programs -> MOTORTECH -> MOTORTECH Flash 
Tool -> x.x.x (e.g. 0.9.00003) -> MOTORTECH Flash Tool. 

▸ The MOTORTECH Flash Tool will now start. 

▸ The software automatically checks all USB ports for connected devices. 

3. In the Status section under Device, check if your device has been recognized properly. 

▸ If the MOTORTECH Flash Tool was unable to detect a device even though it is connected 
to your computer via the USB interface and the USB drivers have been installed 
correctly, you can usually still update the firmware. To do so, observe the instructions in 
the information windows of the MOTORTECH Flash Tool for the following steps. 

4. Select in area File using the Select button the desired update file. 

5. By reading the displayed file information, ensure that the update file is correct for your 
device. 

6. Start the update process using the Flash button or using the menu or toolbar. 

▸ The ignition controller is restarted automatically. 

▸ Now, a window opens informing you about the firmware version currently used on your 
ignition controller and also about the relevant update version. 

7. Confirm with Yes to proceed with the update process. 

▸ Now the update will start. 

▸ If the firmware update was successful, you will see a relevant message. 

8. After a successful firmware update, check all configuration data. 

  

 

Downgrade process 

The process for a downgrade is largely the same as the update process. You 
will only be informed that a new firmware has been installed on the device. 
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Help with connection problems 

If a correctly connected device is not found during the automatic search, 
this can, for example, be because too many communication interfaces are 
assigned and must be checked. In this case, an interface from the drop-
down list Port in the area Connection can be selected and thus specified. 

If the desired port is not yet displayed in the list or if the problem should 
continue, an adjustment of the time-outs for the connection helps. The 
time-out settings are displayed in the main view by the following entry in 
the menu bar: View -> Extended connection settings 

Enter the following settings: 

– Update Request Timeout 
Adjustment range: 1,000 ms to 10,000 ms, standard value: 3,000 ms. 
An extension of the time-out can be an advantage, especially with 
connection problems that occur because the computer has many 
assigned ports. 

– Start Timeout 
Adjustment range: 1,000 ms to 10,000 ms, standard value: 3,000 ms. A 
time-out change can be an advantage, especially with connection 
problems that occur because the communication between the computer 
and the device has been interrupted. 
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10.1  Possible Faults 
The MIC100 ignition controllers include several safety functions that can shut down the engine 
in case of fault: 

– Overspeed protection 

– External shut-down contact (Start/Stop) 

– Misfire detection (primary) 

– Internal failure of the high voltage supply 

– Output Error Detection 

– Shut down in the case of a faulty pickup or faulty pickup signals. 

– Faulty voltage supply 

– External EMI signals 

– Overtemperature shutdown 
 

10.2  Causes of Faults 

10.2.1 Overspeed 
The engine speed has exceeded the set overspeed value. An operating error caused by 
overspeed is indicated on the device by the status LED flashing four times (4 times red/off 250 
ms, 750 ms off). Refer to the section LED Functions on page 25. 

Potential Causes 
– Speed controller does not function properly 

– Fuel supply to engine is not optimal. 

– Faulty pickup signal 
 

10.2.2 Output Error Detection 
An internal failure of the high voltage supply or a defective output switch occurs. 

Potential Causes 
– Hardware fault on the MIC100 

– Defect in the wiring (short circuit or open circuit) 
 

10 Errors 
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10.2.3 Misfire Detection (Primary) 
Misfiring due to an open circuit on the primary side was detected and displayed in the runtime 
data. 

Potential Causes 
– Defect in the output wiring 

– Ignition coil defective 
 

10.2.4 Pickup Input Errors 
Faulty input signals from the pickup are detected. A pickup input error is indicated on the device 
by the status LED flashing twice (2 times red/off 250 ms, 750 ms off). Refer to the section LED 
Functions on page 25. 

Potential Causes 
– Number of events does not match the set number 

– Damage to or uneven running of trigger disc 

– Interference in the wiring of the pickup 

– Wiring of the pickup incorrect 

– Distance of the pickup incorrect 

– Dirt on the pickup 
 

10.2.5 Acknowledging Faults 
While the engine is shut down, you have the following options for acknowledging operational 
errors:  

– Use Error Acknowledge in the MICT 

– By disconnecting the supply voltage 

– Acknowledgement of the error via CAN-Bus 
 

10.3  Customer Service Information 
You can reach our customer service during business hours at the following phone and fax 
number, or by email: 

Phone:  +49 5141 93 99 0 

Fax:  +49 5141 93 99 99 

Email:  service@motortech.de 
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10.4  Returning Equipment for Repair/Inspection 
To return the device for repair and inspection, obtain a return form and return number from 
MOTORTECH. 

Fill out the return form completely. The completely filled out return form guarantees fast, 
uncomplicated processing of your repair order. 

Send the device and the return form to one of the two addresses below or to the nearest 
MOTORTECH representative: 

  
MOTORTECH GmbH 
Hogrevestr. 21-23 
29223 Celle 

Germany 

Phone:  +49 5141 93 99 0 
Fax:  +49 5141 93 99 98 

www.motortech.de 
motortech@motortech.de 

MOTORTECH Americas, LLC 
1400 Dealers Avenue, Suite A 
New Orleans, LA 70123 

USA 

Phone:  +1 504 355 4212 
Fax:  +1 504 355 4217 

www.motortechamericas.com 
info@motortechamericas.com 

  
 

10.5  Instructions for Packaging the Equipment 
For return shipment, equipment should be packaged as follows: 

– Use packaging material that does not damage the equipment surfaces. 

– Wrap the equipment with sturdy materials and stabilize it inside the packaging. 

– Use sturdy adhesive film to seal the packaging. 
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11.1  Maintenance Instructions 
Please follow the following maintenance instructions: 

– Do not use caustic liquids or steam cleaners for cleaning the device.  

– Clean the passive pickup at regular intervals. 

– Check the ignition wires at regular intervals. 

– Replace the pickups at regular intervals if operating them under elevated temperature 
conditions (> +90 °C / > +194 °F). 

– Regularly inspect all wires of the ignition system for damage and replace the wires as 
needed. 

– Check all plug-in connections for proper condition. 

– Service the spark plugs as per the instructions of the spark plug and engine manufacturers. 
 

11.2  Spare Parts and Accessories 
For spare parts and accessories for MIC100 ignition systems, please refer to our current product 
guide, which is available for download on the Internet at www.motortech.de. 

 

11 Maintenance 
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